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General Principles

TYPO3 is divided into two areas - the frontend and the backend. The frontend is the website TYPO3 produces.
Only those with a CMS account are able to access the backend of TYPO3. The backend is for creating new pages
and page content.

Pages vs. page content

A page in TYPO3 is merely a container for page content. A page without any content will be blank. This is no
surprise.

Similarly, content with no page will not be displayed. It exists somewhere but has no home.

Both a page and page content is necessary to get what we might think of as a “finished web page,” but the content
is not entered “into” the page.

Importing site vs. daily maintenance

Several frustrations arise when first converting to the TYPO3 CMS technology. The CMS paradigm is radically
different from the “old way” that it can take some adjusting, re-learning, and solving the same problem in a
different way. TYPO3 solves many problems or shortcomings of the “old way” but until you have learned how to
use it, you may experience some frustrations.

If anything does not seem as easy as you want it to be, consult with a TYPO3 trainer to see if there is a better way
to solve the task at hand.

Once your site is into “*maintenance mode,” TYPO3 will be much easier to use. Instead of thinking of how to solve
a problem, you might be editing simple content to update information. Also, after getting used to it, you will
discover that it is a powerful tool that can make web editing easier.

Editorial process

TYPO3 supports an editorial process through “workflows.” These are work areas configured to have “authors,”
“reviewers” and “publishers,” much like printed publications.

This is not a mandatory configuration when using TYPO3, but the instructions throughout are written from the
perspective of not using the workflow. You should not notice any differences while authoring content, but before it
appears on the finished web site (the frontend), an author must “submit content for review.”

If you are uncertain if you are using a workflow, contact your TYPO3 trainer or department TYPO3 expert.
Login

Let's start from the beginning.

1. Make sure you have cookies and Javascript enabled or TYPO3 will not work

2. Allow pop-ups from TYPO3 (www.cms.ndsu.edu) in your browser **very important, do not proceed without
verifying this step every time you use TYPO3**
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3. Enter the TYPO3 URL in the address bar [1-1] of your Internet browser to get to the Log In page

The URL is http://www.cms.ndsu.edu/typo3
4. Now you will see the screen shown in Figure 1

E TYPO3 Login: NDSU - Mozilla Firefox

File Edit View Go Bookmarks Tools Help

g

g::l - EL'J = I:.l @ |@ https://www.cms.ndsu.edu/typo3f_

TYPO3 Y

Username: | ——{2]
Password: | ——— [3]
Interface: | Backend ~|

Log In

(Mote: Cookies and JavaScript must be enabled!)

=

[1]

v G

[2]

-

<] R

I

Figure 1 - TYPO3 login screen

5.
6.
7. Click the Log In button or press [Enter]

Logout

Done | www.cms.ndsu.edu ﬂ|

In the Username box type your username [1-2] (same as NDSU e-mail username)
In Password box type your password [1-3] (same as NDSU e-mail password)

Please note that if you do not manually log out of TYPO3, your session will time out after approximately 30 idle

minutes.

If this happens and you wish to log back in and continue work, log back in using the pop-up login window. **This

is why allowing pop-ups is important. If this pop-up window does not appear, you will miss the time-out

notification and may lose work as a result**

Overview

After you log in, TYPO3 should look something like Figure 2.
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File Edit View Go

Bookmarks

Tools Help

G- - 0 ) | O hpswww.cms.ndsu.eduftypod/alt_main.php

|| Red Hat, Inc.

TYPO3 ¥

Web [1] =
- {

[2]

Page

View

List

Info
Access
¥%  Functions

ersioning

Filelist
User 17
7 Setup
" Workspace

@. About module

Help

LI Red Hat Network ( JSupport | 'Shop | Products

: [y s otting 21 .

www.its.ndsu.edu

FAQs and Help Docs
Instruction and Research
Training & Resources

Professional Services

www.cms.ndsu.edu

=

]

CMS5 Links

CMS Home

Knowledge Base
Get an account
To Begin
TYPO3 tour
General Principles
Template concepts
Suggested BE configur
Make content accessibl
Submit to Reviewer
Create New Pages

Add Content to Pages

{1 Training

Path: /www.its.ndsu.ed.../
Yr 2@

Pagecontent

; www . its.ndsu.edu

_ B

~

Workspace: "its_offline” Mew version of page
@
NORMAL
&

Default Insert plugin

Index: Yes
Flugin: News
CODE:

Default Text

A

|| Frame: Frame 1

Index: Yes
alt="AskQ. The text sizes on this site are too small

| for me to see easily, how can I change the text
size?

| A. Go to View > Text Size in your browser and
select a different size,
Q. How do I get my user name?

| A, Activate your user name (electronic ID) at
http:/fenroll.nodak. edu. Please visit our getting
started guide for more information.
Q: [ forgot my e-mail password. How can I obtain a
new password?

| A Come to the Help Desk in IACC 150 during
business hours with your NDSU Bison Card
ID.&nbsp; A Help Desk representative will give

[+] you a new password.

on't remember my Blackboard

Images
)] Forms
[ Ex[:.\/anﬂ VL Section Index
Logout Links
[berkeleyus [5] = RTE (Rich Text Edit
[ Iz S IS Z E
Edit/Search: | == [6] )

Done

Q.

ST S TS ST

&l 0 [d

Columns

BORDER
L
Default Insert plugin

Index: Yes

Plugin: Random Images
CODE:

Default Insert plugin

Index: Yes
Plugin: News
CODE:

Default Insert plugin =3¢

Hide: Yes
Index: Yes

Plugin: Extended Calendar
CODE:

Default Insert plugin

Index: Yes

Plugin: Extended Calendar
CODE: E
Frontend Preview: [« ' ‘ 1: its_offline ~| (@

www.cms.ndsu.edu (|

Figure 2 - TYPO3 backend

In the screen shot you can see that there are 3 columns on the page.
[2-1] The left most column is the TYPO3 column (TYPO3 modules)
[2-2] The second column is the website navigation column. This is your Web site's page tree (note: depending on

your permissions, you may or may not see the entire tree for your site)

[2-3] The third column is the work area

[2-4] Use the logout button to close Typo3

Note - save work before logging out, as your work will not be auto-saved at any time

[2-5] Below the logout button, the current user is shown

[2-6] Search for a page by its ID number or name. If you are working with a lot of pages, this may be faster than

scrolling to trying to find the page
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Typo3 Column (left most column)

TYPO3 v The TYPO3 column, shown in Figure 3, helps you choose your work area. You will be mostly
= . ézusing the 'Page' sub-module (in the Web module).
Page Clicking on the text link next to the icon activates that module in the work area.
View
- Website Navigation Column (middle column)
@ Info Clicking on the Page module in the TYPO3 column will .- N1 ¥ ofmia
o Access open up the Navigation Column illustrated in Figure 4 if - ) www.its.ndsu.edu.—l‘[]']
oo —— it is not already open. This is the actual page structure FAQs and Help Docs
I:-E; Varsianing on your web site.. . . Instruction and Research
& [4-1] By convention, the root of each web site will be Training & Resources
File = named exactly as the web URL (i.e. www.its.ndsu.edu Profassional Services
Filelist or www.cms.ndsu.edu as shown in the example graphic - WWW.crms. nidsy.edu
_|at right). = =)
Uy = [4-2] Clicking on the plus sign [ expands the directory [2] & ﬁs ,.13(”:3
J,ﬂ., Setup tree Clicking on the minus sign & folds the directory + 3 Knowledge Base
‘.' Workspace tree. 4
Help - i . . . i s
& |[4-3] The icons in the page tree provide useful L N
ﬁ} About moduled |information about the page. In example, the purple Calendar
a About tilde — indicates a page that is a spacer. This page [5] e
— will not create a link in the rendered page (and should
&l Manual not contain any page content). The green arrow © 'E{ Reians. e iras - iram sarvan
13) indicates a shortcut. This page also does not contain
I™ Expand all any content, but it is a shortcut to another page in the Figure 4 - Navigation
Logout navigation tree. < column
[berkeley] L_IThe red X on the page icon (not shown in Figure 4)
; indicates that this page is hidden and is not visible in the frontend, although you can preview

the page while logged into TYPO3.
Figure 3 - TYPO3 [4-4] The plain white page icon indicates a regular page and the gray page icon
column indicates a regular page that is hidden in the navigation menu. The hidden-in-navigation is a
page that is available in the frontend but does not appear in the navigation menu of the
finished Web page.
[4-5] Clicking the green arrow icon ii refreshes the page tree.

Note - Hovering the mouse cursor over the page icons described above turns the cursor into a hand and displays
the page ID and the page status (hidden, or hide in menu) if applicable. As Typo3 is a database driven program,
every page and content element has a unique ID number assigned to it automatically. This makes it easier to keep

track of information.

Typo3 Tutorial - Overview - Typo3 Module [ Page 7 ]
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Note - In the second column, clicking the page name [5-name] opens the page

in the work area and clicking on the page icon [5-icon] opens up a context
(also called right-click or pop-up) menu with different options [5-1]. You can
also right-click (or control-click if you use a Mac) to bring up the context

menu.
Work Area (right column)

The work area is where changes are made. The area will look different
depending on the active module.

1. Click on the Page sub-module in the Typo3 column
2. In the website navigation column, click on the name of the page
* Clicking on the white page icon next to the page name and selecting
Edit from the menu will have the same result
3. Now you will be in the work area

Editing Existing Page Content

The edit work area can be accessed

L

its_offline

www.L;&&:lsu‘.ﬁdu

[icon] [name]

Instruction and Research
Training & Resources

Professional Services

T VTR TR T AN || R—

| Show

=t 1]

New &
Info J
Copy "R
Cut &
Versioning (aa]
More options...

Hide b
Visibility settings &
Edit page properties .

NMalata fm

Figure 5 - TYPO3 context

menu

. by clicking on the white page icon in the Navigation Column and then Edit from the drop down menu

or

* by clicking the Page module and then on the page name in the Navigation Column

Your work area will now look something like Figure 6.
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;2 . General Principles Columns d P

Path: ....cms.ndsu.ed.../Knowledge Base/General .
Princip.../

Y s e, @®
Pagecontent A

Workspace: 'its_offline’ Mew version of page

Edit Page Properties | Move page | New page | New content
@
NORMAL BORDER
O e &

Default Menu/Sitermap

.-‘-ﬁ-{@

Index: Yes

Default Text A

.-1#1@

Index: Yes
Backend and frontend
TYPO3 is divided into two areas--the frontend and the
backend.&nbsp; The frontend is the website TYPO3 produces for the
viewing pleasure of all.&nbsp; Cnly those with a CMS account are
gble to access the backend of TYPO3.&nbsp; The backend is for
creating new pages and page content,

Edit in Rich Text Editor

Default Text A
]

G |

Index: Yes

- Backend modules
Tha rantante in tha laffmact caliimn Af tha TYEMR haclrand ara lenawn

Figure 6 - TYPO3 work area

You can access your content information to edit in 3 different ways.

Defau-['g]t A
- = [7-1] Click on the text itself. Notice that the text
v {lﬂ changes color when you hover the mouse cursor
Index: Yes
Backend and frontend over the text - note that workspace/workflow
TYPO3 is divided into fwo area_s——the frontt_and and the users will not see “content” here until the page has
backend. B&inbgose| meeng is the website TYPOS3 produces for the .

been published

viewing pleasure of all.@nbsp; Only those with a CMS account are
able _to access the backend of TYPO3 . &nbsp; The backend is for [7-2] Click on 'Edit in Rich Text Editor' button -
creating new pages and pac_'l':z'] itent.

Edit in Rich Text Editor— note this opens a full-screen editor that does not

include all configuration options

- i il i 3
Figure 7 - Editing content [7-3] Click on the pencil icon J for the element

Your screen will now look like Figure 8.
There are a lot more options here than just the text you want to edit. A full explanation is in the reference section

of the tutorial about editing the page header (page 14) — need to update.

Typo3 Tutorial - Overview - Typo3 Module [ Page 9 ]
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- Edit page content screen
=l =l | ik .4 b 4 @ Backend and frontend »| @ | [menu] -l @
Path: fwww.cms.ndsu.ed.. /Knowledge Base/General Princip.../

N e — [8-1] The wording of the header of the page

can be changed here.

@ Type:
Text =
Columns: To top:
normal x| @® T @ [8-2] The text of the page/content can be
(&) Header: directly changed in the rich text editor
Backeﬁ\.[i:!llltend 5 Y K
Align: Type: Link: (RTE).
= @®  Normal <{@® T C S
o
@ Text: If you only want to see the text you are
Parmgraph: | ettt w| Tt el v editing, [8-3] Click the Full Screen Rich Text

Editing button El for full screen Rich Text
Editing. This will remove the configuration

narmal B I U sk X XM TS
AN el EE A CHRBLIBIIM@

TYPO3 is divided into two areas--the frontend and the backend. The frontend is the
website TYPO3 produces for the viewing pleasure of all. Only those with a CMS
account are able to access the backend of TYPO3, The backend is for creating new

pages and page content.\ /
21

sections and display only the RTE.

3
[ \!EI [8-4] To configure options, such as hide,
[T start or stop, use the General options
section.

Rich Text Editor

In the Rich Text Editor (RTE), any mistakes

@ Disable Rich Text Editor: can be easily undone by pressing [CTRL]-

r
(@ Properties:
| Bold [ Italics [~ Underline [ Uppercase

[Z] or the undo button £ at the top of
the editor.

General options; 4
Hide: ? [ ]\‘\.step:
r@ 2 @ :
@ @l = Once you have made changes you can click
Bl R B¢ % | @ the save document button EI to save
[+ Show secondary options (palettes) changes and continue editing, the save and
[Show field descriptions .
[Disable Rich Text Editor (RTE) view button to save changes and
% . .
- preview current progress in a browser, or

. , the save and close button.
Figure 8 - Edit page content

If you like the way the page looks you are done. If it is not quite to your liking, go back and make changes until

you are satisfied with the resulting page.

For details about the Rich Text Editor go to page 32 — need to update.

Adding New Content to Page — need to relocate

Once you click on the [New Content] big button on your edit page content screen in the work area you will the

content element type selection screen, as in Figure 9.

Typo3 Tutorial - Overview - Typo3 Module [ Page 10 ]
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1: Select Type Of Content Element:
Please select the type of page content you wish to create:

Typical page oL
, egular text element
A regular text element with header and bodytext fields.

Text w
ny number of images wrapped right around a regular text element.
| Images only
* Any number of images aligned in columns and rows with & caption.
(" (=] Bullet list

E A single bullet list.
- lﬁ‘ Table

== A simple table with up to 8 columns.|

-

Makes a list of files for download.
clip.

Special elements
. Filelinks
Multimedia
Inserts a media element like a Flash animation, audio file or video
" Sitemap
Creates a sitemap of the website.

Form elements

(e Mail form

A mail form allowing website users to submit responses.
- E Search form

Draws a search form and the searchresult if a search is performed.

Figure 9 - Content type selector

2: Select Positipn:

Now, click the position where you wish to plac ' . . .
2. You will see 2: SELECT POSITION:, as in Figure 10

For most new page content you will select ‘Regular text element’

NORMAL BORI3  Choose where you want to place the new page content by clicking on

g tte] the gray arrow where you want the content to be placed

A Backend and frontend
Insert site maps
A Backend modules
A FPagetree 1. To insert a site map, add new content as above but choose “Sitemap”
E'A T instead of “Regular text element”

Insert new record here 2. Select the location for the sitemap in the page
A 3. The menu type offers several options for what kind of site map should
44| Mathmeny be created

. . a) Menu of these pages
Figure 10 - Content position

selector

2. This allows you to select several pages to appear in a
navigation menu that are not necessarily near to each other
in the TYPO3 tree
a) Menu of subpages to these pages
* This allows you to select a page (or more) whose child pages should be displayed in a menu
b) Menu of subpages to these pages (with abstract)
* Is like item 2, except that the abstract (inserted in the page properties) is also displayed with the link
c) Menu of subpages to these pages + sections

Typo3 Tutorial - Overview - Typo3 Module [ Page 11 ]
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* Is like item 2, except that it also inserts links to the sections of each sub page
d) Sitemap

| ”

» Is the typical “sitemap.” You can select where the “root” of the site should be, so it doesn't need to
span the entire site!
e) Section index (pagecontent w/Index checked)
* This is a long way of saying that a section index or “table of contents” will be created for the page.
Some call these “jump to...” links
f) Recently updated pages
g) Related pages (based on keywords)
note - available sitemap versions may vary depending on your permissions
4. Specify a Startingpoint: by clicking the file browser icon and choosing a page

5. Save and close or preview the site map

Undo/history

There are several occasions that may warrant an investigation of the history of a TYPO3 page or page content
element.

Interest in page history
TYPO3 can be used as a collaboration tool. The history tool and TYPO3's version tracking facilitates a cooperative
editing environment.

While working in groups on a document, it may be useful to see the changes made by another contributor. Page
change history is kept for at least 30 days. History older than 30 days is not guaranteed to be available.

Find current working status of content

(applicable in workspaces only)

Working collaboratively, or even independently, it may be useful to see a summary of changes made to a
document. Working in the offline workspace, the Versioning module shows a summary of all content differences
from the current published version.

The workspace also shows the current working status of a page or page content.

Find and revert changes to content or page

To find specific changes to a page or page content, use the history feature.

Locate a history/undo button or right-click on the page in the tree and select History/Undo. The view in the
working area will now appear similar to the FIGURE ##.

If you decide a change in the history view should be reverted, click the undo button in that row. The interface will
change to look like FIGURE ###.

Typo3 Tutorial - Overview - Typo3 Module [ Page 12 ]
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Read more about history/undo at TYPO3.org -> http://typo3.org/documentation/tips-tricks/the-undohistory-
feature/

Adding a New Page

Adding a new page can be done in two ways: through the context menu or with big buttons.

Adding a New Page — context menu

1. Click on the page icon in the Website Navigation Column
2. From the context menu menu select New
Now your work area should look like Figure 11.

New record

= ~ Knowledge Base

Page (inside)

& Click here for wizard! \?J
A Pagecontent

& Click here for wizard! k?f
"c:<l9) News &
Page (after) &

4 Create a new page

Figure 11 - New record menu
* Clicking on Page inside will bring up immediately the New record page information. Note that you will not be
prompted for the position of the page in this mode. The page will automatically be located “inside” (or as a
child) from the page you executed the “New record” from. This is not the suggested method for creating new
pages unless you know what you're doing.
* Clicking on Click here for wizard! or Create a new page will also bring up the ‘New record’ screen discussed
above.

Adding a New Page — big button

Click on the page title the Navigation Column where you want to add the page and the work area will open as
normal.

Click on the [New Page] big button and you will see the New record position screen.

Select where you want to add the page in the directory tree of your website. If you place it someplace by mistake
you can move it later with the move page option.

New Page Screen

Typo3 Tutorial - Overview - Typo3 Module [ Page 13 ]
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After selecting where to create a new page, the page configuration will display in the work area, as shown in Figure
12.

The only mandatory information to enter here is the Pagetitle. This is indicated by the yellow exclamation icon
next to the Pagetitle text field. It is highlighted by a red circle in Figure 12.

Path: /www.cms.ndsu.ed.../Knowledge Base/

Page NEW - [PID: 337] Knowledge Base

#® Hide page:
=
@ Type:
Standard d |
'Mew' until:

N @®

. Pagetitle:
Alias: S5L mode

=

=

@
(@ Hide in menu;
r
#) Localization settings:
[ Hide default translation of page
[ Hide page if no translation for current language exists

General options:

Start: Stop: Include subpages:
I @ I @ Ire®
General options (continued):
Access:
Selected: __ Iltems:
[~]€ | Hide at login [+]

& | show at any login
& _ Usergroups:__

4
[~I5¢
@.
F s ) ) X

[+ Show secondary options (palettes)
[ Show field descriptions
[ Disable Rich Text Editor (RTE)

@

Figure 12 - Page configuration

For more details , continue reading.

Remember that content is entered as “page content,” not “in a page.”

Edit Page Properties

The new page screen is the same one you get by clicking on the 'Edit page properties' in the context menu when
you click on the page icon in the 'Navigation Column' or click the Edit Page Properties big button.

Page Types

Typo3 Tutorial - Overview - Typo3 Module [ Page 14 ]
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There are several types of pages you can create.

You select the option from the Type drop-down menu, shown in Figure 13.

that the available page types may vary by your permissions.

The default page type is Standard.

Below is an explanation of the ‘Standard Type Option’. For all the other

choices, only the differences from Standard are shown.

Standard Type Option

Following is an explanation of each section when standard type is selected.

Hide Page

Path: fwww.cms.ndsu.ed.../Knowledge Base/

Page NEW - [PID: 337] Knowledge Ease

\‘Lllilde page: [1]
Type:
Standard ~— ] [2]
'New' until:

" —=—131

@

Figure 14 - Page configuration

Figure 13 - Page

types
Note

[14-1] By default the page may be hidden. Removing the check mark from the box un-hides the page. This is

important and very easy to forget. Once you save the page and it still shows up with the hide icon you will know

that you have forgotten to remove the check mark. You can un-hide the page by editing the page properties again.

[14-2] By default, ‘Standard’ will be selected. For an explanation of the different types, read the following pages.

[14-3] 'New' until is an option for internal use only. This can help you keep track of what pages need to be

updated.

To see the list of “"New until,”
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Click the Info module Page information

Select a page in the navigation menu = www.cms. ndsu.edu [1]—Pagetree overview :]
Path: /www.cms.ndsu.ed.../

In the top-right pull-down menu, select Pagetree overview

Workspace: "its_offline" New version of page

[15-1]
Pagetree Duarview|
4. Change the report type to Cache and Age [15-2] N /[ 1 [2]
5. Optionally specify the number of levels to be shown [15-3] :::ztle:‘jﬁ - Agem:j Qf;.s: updated: © New until: 5 No
6. Look for the 'New' until dates in the 'New' until column [15- www.cms.ndsu.edu 35 7
4] ~== CMS Links 1706. o [4]
% CMS Home 255._"
+ Knowledge Base 337 >
Search 1707 »
+ Get help 274‘ ~
+ News 455 2
+ Calendar 1806, »
Index 353' )

Page Title

Cimitivra 10C DarmA infAreaakinn

P Pagetitle: s [1]

o} AEE
Alias:-‘ [2] SS5L mor.j—i' [3]
&

-.\‘_?,-Ililde in menu: [4]

Figure 16 - Page configuration

[16-1] This text box has an exclamation mark on a yellow background next to it [l and that means that this field
must be filled in. The title of your web page is important as it will be used in the navigation of your site. Keep it
short and to the point.

[16-2] The Alias is a way to shorten links in the page URL. Say, for instance,
http://www.its.ndsu.edu/fags_and_help_docs is too long ... it could be shortened as just
http://www.its.ndsu.edu/help

Note that this should be used sparingly. Aliases cannot be reused even on another site, so if you select a common

alias, like “help,” you may clobber other (potentially more important) uses for “help” and every page that anyone
has kindly named “Help” without using an alias.

If you have any doubt, do not use an alias without first consulting a friendly TYPO3 expert.
[16-3] SSL mode (secure mode) indicates whether the page should be secured (HTTPS) or insecure
(HTTP) - this will change when the new SSL extension is implemented

[16-4] Hide in menu creates a page that is visible online but that does not appear in the page navigation. This is
useful for “*mechanical” or “behind-the-scenes” pages.

Tsconfig

To be used by TYPO3 experts. Do not tamper with this unless you know what you are doing. Note, depending on
your permissions, you may not even see this section.

General Options

Figure 17 shows the general options in page configuration.
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General options:
Start: Stop: Include subpages:

r @ T @ '®

Figure 17 - Page configuration

Start time determines the date from which the page or content will be visible online. Use this to 'publish' the page
or content on a certain date. If 'Start' time is not set, the page will be online instantly (unless the page is hidden
otherwise).

Stop time is the date from which the page will not be online anymore.

Include Subpages. By default the Start, Stop, Access and Hidden options are effective only for the page on
which they are set. If the option 'Include subpages' is checked for the page, then their effect is inherited by all
subpages of the page.

(Access. If 'Access' is set to a usergroup name, only website users which are members of the selected user group
will be able to view the page when they are logged in. The special option 'Hide at login' means the page will not be
visible when users have logged in).

Advanced Type Option

Page Title

If you have the permissions necessary to do so, the page title section may have an additional field called
'Navigation title'. Here the name for navigation purposes can be different that the page title above.
Abstract, Keywords, Description

Abstract is the abstract for the page. It will not be used in any meta-tags, but is displayed in instances of
“Menu/Sitemap - Menu of subpages to these pages (with abstract).”

Author is not used in the NDSU TYPO3 template at this time.

Keywords is a list of keywords that will be put into the page meta-tags.

Description is a brief description of the page that will be put into the page meta-tags.

Files
This section is not used in the NDSU TYPO3 template at this time. This behavior may change.

External URL Type Option

This page type configures the page as a shortcut to a Web page outside of TYPO3. Do not use this for every
instance when you want to link to an external URL, but rather in cases where the link should appear in site
navigation. It enables links to an external webpage, an ftp page or even an email address.

To use, type the URL in the URL field without any http://. Set the Type to the appropriate type; usually this is
http://.

If you enter a URL that includes “http://,” “https://,” “ftp://,” etc., you MUST change the Type to be blank or the
shortcut will not work.

Typo3 Tutorial - Overview - Typo3 Module [ Page 17 ]
Last modified 01/11/2007



) URL:
google.com
® Type:
httpef/ )

-@

Figure 18 - External URL configuration

Shortcut Type Option

This page type is very similar to the External URL except that it links to a page within TYPO3.

® Shortcut to page:
[ &
[¥]

Page

Figure 19 - Shortcut configuration

To add a shortcut to a page click on the ‘Browse for records’ button and the element browser will pop up.

E https://www.cms.ndsu.edu - TYPO3 Element Browser - Mozilla Firefox

Creating a Shortcut to a Page = ! — Recordylzl
sh.edu

- www.its.i.l » & + Knowledge Base
From the ‘Page tree,’ select the page to FAQs gnd Help Docs B Page (13) @ @
B Instruction and Research ] e
which you want to make a shortcut. If = sz
Training & Resources * + Get an account
the page is not visible click on the plus R e = + To Begin
sign 1 to expand the page tree and = www.cms . ndsu.edu » + TYPO3 tour
click the title of the page [20-1]. il =15 Links 3 + General Principles
% CMS Home + Template concepts
H - % Knowledge Base S ted BE fi ti
Creating a Shortcut to Page Content . Q FEHNSEN R CoiauarHon
Get an account + Make content accessible
To Begin L3 + Submit to Reviewer
If you want to create a shortcut TYPO3 tour )

+ Create New Pages

[#]

directly to a content section of a page, General Principles _ + Add Content to Paqcir_ E'|Z|
click on the small right arrow [ after | pone

| www.cms.ndsu.edu (5

the name of the file. The Select

Records option will display in the right Figure 20 - Shortcut configuration
column [20-2]. Click the name of the

section.

Not in Menu Type Option

This is equivalent to checking the “Hide in menu” box when creating a new page.
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Spacer Type Options

This option serves no other purpose than to add a line/empty space into the navigation menu.

Move a Page

If you placed a page in the wrong spot or just want to move it to a new location, you can move it.

Drag and drop

To Begin To Begin
Click the page icon of the page you want to move TYPO3 tour TYPO3 tour
2. Hold the mouse button down and drag the page to the General PRMESES ["Move pageinte 3 |

new location (shown in Figure 22) Template concepts Move page after #
Copy page into 3

Suggested BE configur
ae = Copy page atter & |7

3. Release the page when it is in the right location

4. A menu will appear asking if you want to copy or move
the page into or after the location specified (shown in Figure 22 - Move Figure 21 - Move
Figure 21). Select the option you want, according to page detail page menu options
Table 1, below

Menu item Meaning

Move page into Make the page a child page of the target location in the first position available
Move page after Make the page a sibling of the target location in the first position available

Copy page into Copy the page to be a child page of the target location in the first position available
Copy page after Copy the page as a sibling of the target location in the first position available

Table 1 - Move page menu options

5. If any error messages are reported, copy them exactly to show to a TYPO3 administrator

Note that if you use an offline workspace, you can only move a page before it has been published. After it has
been published, you need to talk to the person in your group that publishes pages in TYPO3. He/she can move the

page for you.

List module

The alternate method to move a page involves using the List module.

1. Click on the List module

2. Click on the parent of the page you want to move

3. Click the Move up in list or Move down in list buttons to move the page up or down, as shown in Figure 23

Cut and paste
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TYPOS3 tour

General Principles
Template concepts
Suggested BE configuration

=
=

=

HEE 5 f

B B B B

&
<
3
&
%
o
£}
%
L
-
L;

Figure 23 - Move page from Web>List module

The third way to move a page involves using cut-and-paste.

Click the page icon of the page you wish to move

N

Select Cut from the context menu

W

Copy a Page

Click the page icon of the page you wish to paste into or after
Select “Paste into” if you want to make the page a child or “Paste after” to make the page a sibling

Copying pages is not recommended practice, since it defeats the purpose of re-using content. Instead, use “Insert

Records,” detailed later on.

However, if you do want to copy a page, the suggested method is to

1. Click the page icon of the page to copy
Select Copy from the context menu

2
3. Click the page icon of the page you want to paste into or after
4

Select “Paste into” if you want to make the page a child or “Paste after” to make the page a sibling

Note that copied pages will be hidden by default and will have (copy 1) in the title of the page. Edit the page (Edit

Page Properties) and make changes as necessary.

Basic Reference Information

Context Menu Options
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Clicking on the page icon opens up this context menu. ek

Show
Here is a list of the context menu options. Badie |
.Naw EN
*  Show | Infa :
| )
* Edit Copy (g
N | Cut =
ew | Versioning HH
* Info | More options...
e Copy Hide ¢
. cut | Visibility settings &)
Versioni | Edit page properties 7
ersioning Delete mj
* More options ... History/Undo %y
* Move page Pages to Clear Cache of

¢ 'Create New' wizard
* Mount as treeroot

Figure 24 - TYPO3

¢ Web > List module
context menu

* Export to .t3d
e Import from .t3d
* Hide
* Visibility settings
* Edit page properties
* Delete
¢ History/Undo
* Pages to Clear Cache of

Web > List Module

Clicking on 'Web>List Module' opens up this screen to the right in the work area, as shown in Figure 25.
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Jwww.cms.ndsu.ed.../Knowledge Base/ '-\.,_,-"' & :-\_.)Lk) _; 2) @
\Workspace: fits_offline! New version of page

4 Page(13) @ (@

Pagetitle: & "3 [Ref]

Get an account S = ‘JQEE B L i @‘ L- IWL&)L"-)
To Begin \ Gl m YEE L @ df@ﬁ. Luld
TYPO3 tour U 0 .2 8  [lew L- 1%&)&.}
General Principles '-',.," =t d’ QEE B ’ & iq @ D LLjLLh
Template concepts '-',.,"' = d’ ﬂm P L K iq @ @D L- IWL&)L“J
i L) e 980 o2 8 [Te e LELGLS

U sl % 0 .28 ([ flee L. 1%&)@ 2
Submit to Reviewer '-',.,‘ C ‘)ﬁ@ #’ '.’ . @ﬁ L L‘)L“J
Create New Pages '-',.,"' =ty ﬁﬂm -&’ '.' i @‘ P L:Il ‘*L&.’}l&)

Add Content to Pages U s 980 . 8 (e L- 1%1-&)[&) 1
[3¢ work with Existing Pages L) e 90 o % 8 g [Te @ LRELGLS

Edit g\ L. 1%1-&)[&) L

Undo changes s I

Pagecontent (3) @ (B

Header: = [Ref]
" A quick introduction \ Lo wie B * @ 4 EB Lllu:f
A TYPO3 with Small Screens [2] R a8 e i B
& Page tree indicators Lo wite B % { EB L'.q‘f
@

[« Extended view—_ [3]
[+ Show clipboard
|~ Localization view

@
CLIPBOARD
Haadl B0 | rmenut I x|

Figure 25 - Web>List module

This is an overview of all the elements associated with the page.

[25-1] Page shows all the other pages that are children to the page. In the current example there are 12 regular
pages and one hidden page.

[25-2] Pagecontent shows the page content elements of the current page. The example has only three content
elements.

[25-3] Note the checkboxes at the bottom of the page. The Extended view shows all of the extra icons for each
page and Show clipboard adds a clipboard to the bottom of the screen that shows any elements you are storing in
the clipboard (from copy or cut).

Rich Text Editor

The basic RTE is shown in Figure 26. Available editing options are at the top of the editor [26-1] much like a word

processor. You will often see more options by right-clicking (or [CTRL]-clicking) the editor work area to bring up
the context menu.
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P Text:

3 r[l]-h: Default ﬂ Texk: | Defmule ﬂ

i Mormal >:B I UabeX: X : M 4 : = =
Alio=aREE AR RLBIIN @
Ask Q. The text sizes on this site are too small for me to see
= -

= i— a—

[*]

easily, how can I change the text size?
. Go to View > Text Size in your browser and select a
different size,

Q. How do I get my user name?
. Activate your user name (electronic ID) at

hitp://enroll.nodak.edu. Please visit our getting started “NiAee
guide for more information. —

Help is a click away

i

Q: I forgot my e-mail password. How can I obtain a new password?
A: Come to the Help Desk in IACC 150 during business hours with your NDSU Bison
Card ID. A Help Desk representative will give you a new password.

Q. I don't remember my Blackboard login/password. Where can I get it? -
A, Access your Blackboard account the same way you access e-mail and the cluster
computers, using your electronic ID (Firstname.Lastname) and password.

Q. I'm looking for @ job on campus. Does ITS have any student openings? E

@- Disable Rich Text Editor:
r

Figure 26 - TYPO3 RTE

Following are the options available in the Rich Text Editor. I am only giving an explanation for icons that are
important for web publishing. Basic word processing functions are self-explanatory.

Headings

[26-1] Use this option to control the look of your text. Clicking opens up the drop

down menu shown in Figure 27.

ormal
| Heading 1
Heading 2

' Heading 3

For normal text select the Normal (p) setting. The definition will already be set for :eag:ng:
i Headling

i i d
your in the style sheet for your Web site. el T

Address

Headings are used for titles with each number the size of the font is successively

Figure 27 - Paragraph
types

smaller. Again there will already be a definition in the style sheet and all you have
to do is select the size you need. Remember that you should not skip levels (for
accessibility).

Font Style & Font Size
This feature is disabled.
Color Text

This feature is disabled.

Paragraph style
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Select in a paragraph and then choose a paragraph style from the Paragraph: pull-down menu to apply the style.
Note that styles vary by Web site and may appear when you preview the page.

Text (Character) style

Highlight/select text and then choose a character style from the Text: pull-down menu to apply the style. Note
that the styles vary by Web site and may appear different when you preview the page.

Insert Link & Remove Link

Clicking on the link icon & lets you add and remve hyperlinks. Click on the insert link icon and you will see the
screen in Figure 28.

E https:/fwww.crms.ndsu.edu - Insert/Modify Link - Mozilla ="-_ ;I:

B
Remova linld Page ‘Fl!.:« S Email —-[4]

URL

Current Link: Page "AskIT’ (ID:1052)

Target: = []-] = Z
Open in window: | Width ;I % | Height '_i
Style: internal-link [2] |
Title: Internal link T —— [3] il
Update
Page tree:
- wviw.its.ndsu.edu >
FAQs and Help Docs 3

Instruction and Research [5] >
Training & Resources / [

Professional Services *

)
k4
e = :

Done www.cms.ndsu.edu (5|
E=--—-— -

Figure 28 - Link configuration
[28-1] The
Target and Open in window options should not be used, and may be disabled to avoid accidental use.
[28-2] The Style for the link determines how the link will look in the finished Web page. The options may vary by
web site, so choose one and see how it looks and select a different option if it is not right.
[28-3] The Title for the link is the text that displays when the mouse cursor is hovered over the link in the web
page. This is useful if you want to make a link that says one thing in text, but has additional information when

hovering with the mouse.

Page

[28-4] In the tab list, Page is selected by default. This tab lets you link to a page or page content on your website.
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To create a link to a page: select the page from the page tree [28-5] by clicking the page name and your link will be
automatically added.

Page content
Linking to a page's content section comes in handy when you want to link directly to a section in the page that

might be midway down the page. Link to it by clicking on the arrow [ to the right of the page's name and then
select the content from 'Content elements' and your link will be automatically added.

File

By selecting the 'File Tab' you can create a link to a file on your website. The file can be a picture or a document
that you want to share.

Clicking on the name of the file automatically creates the link to it.
External URL

By selecting the 'External URL Tab' you can insert a hyperlink to another page on the Internet. Copy the URL from
your browser's address bar and paste it into the box or type the URL directly into the box.

Press the [Set Link] button to save the link.

Also, if you type a URL in the RTE, it will automatically become a link.

Verify links by right-clicking (or [CTRL]-clicking) a link and choosing Check Link from the context menu.
Email

By Selecting the 'Email Tab' you can link to an e-mail address.

Type the address in the 'Email address:' box and press the [Set Link] button.

Also, if you type an e-mail address in the RTE, it will automatically become an e-mail link.
Remove Link

Clicking on the 'Remove link tab' will automatically remove any hyperlink from your document. The tab will not be
colored green to show it is active, you just click it and will be back in the Rich Text Editor.

Insert Table

Clicking the 'Insert Table' icon _:I will open up the screen in Figure 29.
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E https:/fwww.cms.ndsu.edu - Insert Table - M‘atﬂh irefox

~ Dimension —_ [1] 5
Rows: E Cnls:\ﬁﬁ\ﬂiidt: IlCCI IF‘Ercent LI
~ Border — Spacing and padding

Border thickness: Il - [2] Cell spacing: |l
| —
Cell padding: |l

(8]34 I Cancel I

| Daone I www.cms.ndsu.edu )

Figure 29- TYPO3 table configuration

This option helps you define how your table is going to look. You decide how many rows and columns it is going
to have [29-1], as well as the width in the browser window. Specifying width in pixels is not recommended.
Instead use Em or Percent. One Em is approximately equal to the height of one character.

For now, you can leave the border, spacing, and padding [29-2] as default. We will edit these later.

The resulting table will look similar to Figure 30.

B T e T TRy B o] R e e |
o i 5] 3 G
[ 2 ’ i h ¥
i1 — : t t
[ i i i i
.:L .................... [ s A T A R D e e e L e e e i H e e iy A i S a ey o ]:
e e e et ek et s e e e e et e O

Figure 30 - TYPO3 Table

Enter text and styles in each cell as normal.

Each cell has an “add/remove” shortcut to the top and left of the cell - -
[30-1]. To add columns, click the left or right arrow in the column
(top) of the cell and to add rows, click the top or bottom arrow in the - -
row (left) of the cell [31-1]. To delete a row or column, click the
circled X [31-2] for the row or column. .

" [31-2] for the row or colu Figure 31 - TYPO3 add/delete table

rows

Table configuration
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To configure the table, use the context (right-click) menu shown in Figure 32. Right-click

(or [CTRL]-click) in a table cell to access this menu.

~ Description
Caption: I -~
Summary: I — [1]
- €SS Style
Table: IDefault E— [2]
Body: IL‘-: fault =
i Layout
[3] - idth |J.co percent v [4]
Seteight: [ [percent | Fioat: [Notset =<1
— Ali Spacing and padding
[5] ==Text alignment: I Not set li [6] = Cell spacing: |1 pixels
\Te‘rt\:al alignment: INot set :l ™ cell padding: |1 pixels

Done

oK Cancel

Table Properties

The table properties screen allows

you to set how the table will look in7

the finished Web page.

[33-1] In the Description section,
the Caption is for text that will be
displayed VISIBLY in the finished
Web page. The Summary is a
mandatory field (for accessibility)
that should summarize the

Figure 33 - Table configuration

'contents of the table.

[33-2] To achieve different styles
(borders, backgrounds, etc), select

from the CSS Style > Table pull-down menu. Note that styles may appear different for

each web site and may look different in the editor than on the finished Web page.

[33-3] In the Layout section, you can specify a Width and Height for the finished table if

you have not already done so. Again, pixels are not recommended. To float the table to

the right or left of the page, use the Float [33-4] option.

[33-5] To specify the alignment of the text vertically and
horizontally, use the text and vertical alignment options.

[33-6] To space or pad the content, use the Spacing and Padding.
Cell spacing is the amount of white space between each cell. Cell

ltissetto

Pasie

S B |5

Call Froperies..

Insertcell belore

i
i

Insertcell afier
Dielete Call
Merge Calls

Rowi Properies..

¥

e L&" |E|:. v Bl tt .5 ;

Insert Row Betore
Inzert Row Afer
Delete Row

Insert Column Before

=

e

Insert Column Afier

o,

Delete Column
Table Froperies...
Toggle borders
_Ius-iﬁ.v Laft

Jusify Center

Jusify Right

11 S e

Jusify Full
Remove the sk ble= Element..
Insert paragraph befare

Insert paragraph afier

Figure 32 - Table
context menu

0

/ This isthe Cellpadding,

text

tesxt

padding is the amount of padding between the cell wall and its

contents. See Figure 34 for further explanation of padding vs.

spacing.

Insert Picture

ltizzsetto s

Thisisthe Cellspacing,

Figure 34 - Cellspacing vs. Cellpadding. Image from

http://en.wikibooks.org/wiki/HTML_Programming/T

ables
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To insert a picture into your Web page, click on the 'Insert Picture' El e 5 x|
icon . You will see the screen in Figure 35. | New Magic tmage e -1_[1]
Folder tree:
W wwvi.its.ndsu.edu
There are three tabs [35-1] enabling you to insert images in three ; Clusters
. h
different ways. B \
appdev
% classtech [2]
it desktop
A dss
New Magic Image 0 e
identitymanagement project
. P . . W |
1. To insert a new magic image, put the cursor in the location NG TR )
Done www.cms.ndsu.edu (7

where you want the image

2. Click the image icon and browse through the folders by

Figure 35 - Insert image dialo
clicking the folder names [35-2] g g g

3. Thumbnails will display to show the images in each folder. If you do not see thumbnails and would like to see
thumbnails, scroll to the bottom of the folder list and check the “Display Thumbnails” box
4. Click the name of an image to insert it. The image will “magically” resize to a web-friendly size.

New Plain Image

New plain image works a lot like the magic image, except that it will not “*magically” resize.

Drag 'n Drop

Drag 'n Drop works a lot like the new plain image, except that you can drag it into the RTE in the exact place you
want it. This means you don't need to put your cursor where you want the image before clicking the insert image

icon.

1. Browse through the folder tree to find the image you want to insert
2. Click the image and drag it into the RTE

Upload pictures (or other files)

If your picture is still on your computer there are two ways to upload it. With first way you can only upload one
picture at a time. The second way you can upload up to 10 pictures at the same time.

Upload one picture

If the picture is not yet uploaded to the website, you can do this right from the insert image dialog.
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1. In the file list, browse to the location where Upload Image:

you want to upload the image Path: fileadmin/www.its.ndsu.edu/classtech/

2. In the upload image dialog, shown in [1] Browse... |
Figure 36, click the Browse button Browse... |
3. In the window that opens, find the image Browse...

that you want to upload on your computer | ypload files
[36-1] [~ Overwrite existing files [2]
4. If the image already exists on the TYPO3
server and you want to overwrite it, check Figure 36 - File upload
the Overwrite existing files box [36-2]
5. Click the Upload files button

Now you can insert the picture following the instructions above.

Upload up to 10 pictures

In this version you can upload several pictures or even files at once (up to 10).

Click on *Filelist” in the Typo3 column
In the Navigation column you will now see at the file list. Select the folder where you want to upload your

pictures/file(s) and the work area will look Upload flles
something like Figure 37

. & www.its.ndsu.edu: classtech
3. To enable upload of more than one file, change the

drop-down menu [37-1] to a higher number. Note | i files | [1]
that if you select 10 files, you don't need to upload [~ Overwrite existing files [ ]
all 10 |

4. As before, if the image already exists on the TYPO3 :::::: |
server, check the Overwrite existing files box [37-2] Brnaea
to overwrite the files [3] Browse...

5. Click the Browse button and locate the file on your Browse...
computer that you want to upload [37-3] Hidwaeh

6. After selecting all the files, click the Upload files ::::::
button e

Browse...

N i he pi followi h
Oow you can insert the picture following the Upioad nied| | Bancel

instructions above.

Figure 37 - File upload
Fine-tuning Your Picture

1. To configure the picture, right-click (or [CTRL]-click) and choose properties (or click the image and then click
the image icon) and the Insert/modify image dialog will open as shown in Figure 38
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2. Here you can set the height and width of
the image [38-1]
¢ Alternatively in the RTE you can click

Mew Plain

Current Image
[mage

Drag'n'Drop

and drag from the corners of an image

Width: 150 [1]
to make it larger/smaller. O -
eight: 106 [2]
3. If you want the image to have a border, Border: [0 - S——
check the Border box [38-2] Float: Left -1 —I3]

4. To float the image in the page (makes text Marginleft/right: 0

. Margin top/bottom: 0
wrap around the image), set the Float

Title: Ask IT! Help is a click away =,
option [38-4] Alternate text: Ask IT! Help is a click away [4]
5. Set the Alternate text (required for Update
accessibility) and optionally the title
(displays when your mouse cursor hovers
over the image) [38-4] : T
Done www.cms.ndsu.edu (7|

V1 —]
Horizontal Line ) ] ]
Figure 38 - Image configuration

=

Click the horizontal rule icon #= to insert a vertical line in your Web page. Use this sparingly, as it significantly
breaks up the flow of the page.

Remove formatting

E https://www.cms.ndsuU.s

Click the remove formatting icon ;!'t to remove formatting from the page
content. The dialog shown in Figure 39 will open. This is useful if you paste
content from MS Word or from another Web page. ~ Cleaning Area

Selection ® Al f

Cleaning Area specifies whether the entire element or just the selection should ~ Ty of Tarmatting ta rermave —

be cleaned HTML Formatting: r
Type of formatting to remove MS Word Formatting: [
* HTML Formatting will remove styles from the page such as bold, fncgee
color, font, etc. Use this if you paste from MS Word or from another All HTML tags: [
Web page
e MS Word Formatting will remove a few MS Word codes that will Bk Cancel |
break the finished Web page. This is some MS Word-specific coding |
| Done www.cms.ndsu.edu =

and fonts |
* Images will remove images from the contents
* All HTML tags removes all HTML tags. In most cases, this removes Figure 39 - Remove

too much, as it includes <br> (line break) and <p> (paragraph) formatting

tags. This means your content will become a plain-text blob of words

without paragraphs

Typo3 Tutorial - Overview - Typo3 Module [ Page 30 ]
Last modified 01/11/2007



Make accessible content

TYPO3 quick tips

¢ Save your work often. TYPO3 does not auto-save your work. Computers crash so protect yourself early and

often.
* Reuse content. Instead of copying-and-pasting content, reuse it. Then, when the content needs to be updated,

you only update it once instead of many times.

Typo3 Tutorial - Overview - Typo3 Module [ Page 31 ]
Last modified 01/11/2007



